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FOREWORD 
 

The precise purpose of this manual is to promote access to and 

management of information, consequent information empowerment and 

resultant development. Information technology facilitates the process of 

collection, storage, processing and dissemination of information and 

enables instant access to information leading to overall developments in 

any sphere of human endeavour. 
 

Managers and users of information cannot ignore the different kinds of 

abundantly available digital information materials in data, audio, video or 

other formats. They have to organize, maintain and probably disseminate 

the information for pushing development forward. There are many free 

information technology tools that would help in the task. KILA is 

attempting to make a set of easily available and useful software with a 

self-instructional manual, for utilizing those technologies for management 

of data, information and knowledge in diverse development fields. 
 

The manual, along with the cd-rom containing the set of software, will be 

made available to the institutions or individuals engaged in 

decentralisation and local development for building digital archives in their 

institutions, area of activities or personal computers. This publication is a 

significant attempt on the part of our institute to involve in promotion of 

information empowerment in our focus areas. 
  

I congratulate the authors of this manual for their attempt to promote 

creation of prototype digital libraries for wider dissemination and use of 

information. 
 

 

 

 

KILA campus              Dr. P. P. Balan 
26 August 2006                         Director 

Kerala Institute of Local Administration 
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PREFACE 
 

The purpose of this manual is to enable the information 
managers/information users to create the easiest possible prototype digital 
libraries with stable, free software.  
 
Access to information is considered to be a vital determinant of development 
in any human endeavor including academic and research activities and 
hence digital management of information has wider ramifications in this 
world of abundant electronic documents. The technologies described in this 
manual will sharpen the information dissemination capabilities of 
information managers and enhance the access to information resulting in 
information empowerment of a wider constituency of information seekers. 
 
This self-instructional manual describes the methods of creation of digital 
archives with Winisis, GenisisWeb and GenisisCD. The software needed are 
Apache webserver, Winisis, GenisisWeb and GenisisCD. If you have access 
to pdf converter like Adobe Acrobat, you can refine the documents in the 
collection into easily useable e-documents. Html editor will help you modify 
the homepage you create. Anyone with an average knowledge in computers 
can make use of the software dealt with in this manual, if she/he follows 
the instructions diligently.  
 
Institutions can make use of the technologies mentioned in this manual to 
publish their research reports and other publications in internet and cd-roms 
very easily. 
 
We express our gratitude to Mr. David Storti (Unesco), Mr. Chabert Pierre, the 
author of genisis, Mr. Celso Gonzales, Dr. Vimal Kumar Varun (NIC, New 
Delhi), and Mr. Stephen O'Brien for being helpful in answering our queries 
on this. We are thankful to Mr. Jean-Claude Dauphin (Unesco) for agreeing 
to put this document in the Unesco web site. 
 
We are extremely grateful to Prof. A Neelameghan (Bangalore), a doyen in 
the field of librarianship, for his enthusiastic encouragement, proper 
motivation and invaluable guidance. 
 
We have deep indebtedness to Dr P P Balan, Director, Kerala Institute of 
Local Administration, Mulagunnathukavu for providing a conducive 
environment for working on this project and bringing out this manual as a 
publication of the Institute.  
 
KILA Campus                          K. Rajasekharan 

  26 August 2006                                               K. M. Nafala 
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What this manual is all about 
 

This manual deals with creation of a digital archive of documents, in 

different formats, that can be searched by any word appearing in any 

field of the database you create for the archive. 

 

Fig 1 Demo Digital Archive- Homepage 

 
The digital archive will enlist all the included documents sequentially 

when you make a search with the word all, if you had included the word 

in every record. The search result, if so, will appear as follows: - 

 

Fig 2 Demo Digital Archive- Search Result Page 
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Any document in the archive can be retrieved, copied or opened easily 

from the archive and this feature makes the archive a digital library 

equivalent. If the contents of the archive are pdf documents with 

bookmarks, you can reach out to a chapter or a page in the document 

very easily.  

 

The software needed for creation of this archive are included in the              

cd-rom tools attached with this document. The archive can be created in 

any low configuration computer, with minimum learning and efforts. 
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CHAPTER 1 

 
Creation of Digital Archives with Winisis  

 
Winisis, a software for creation of textual database, can be used for 

developing searchable digital archives of full text documents in doc, xls, 

ppt, html, pdf, audio, video or picture format. 

 

A database created with Winisis can be modified as a digital archive by 

adding a command line in its print format so as to display a hyperlink in 

the database display screen that link up the record to an appropriate 

document in the digital document collection. The database can also be 

made web-based with associate software GenisisWeb/GenisisCD. The 

digital archives thus created can be published in intranet, internet or 

CD-ROM.  This manual deals with the modalities of creating digital 

archives. 

 
1.1 WINISIS: the windows version of CDS/ISIS 
 
Winisis is a software developed by Unesco. It is a flexible, easy to use and 

menu-driven generalized information storage and retrieval software 

application. The software is designed specifically for creating and 

managing textual databases. Winisis has capability to create any number 

of databases with completely different data elements. Winisis application 

can be used by anyone having a little computer experience.  

 

Components of Winisis database 

Winisis database comprises of a set of records and each record contains 

a set of fields. A field in a record is a container of data elements. Winisis 

database has a master file containing all the records of the database. An 
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inverted file functions as an index to the master file for faster access to 

any record. 

 

In order to create a Winisis database with any chosen fields, you need to 

define the following components.  

 

• Field Definition Table (FDT):  The FDT defines the fields such as 

Author, Title, Publisher etc. of the records in the database and 

their characteristics. FDT determines the nature of data entry 

worksheet. 

• Data Entry Worksheet(s):  The worksheet is the screen layout 

used to create and/or update the records of the database. Winisis 

provides a specially designed editor to create the worksheet. 

• Print Format (PFT):  The PFT is the format for display or printing 

of records. 

• Field Selection Table(s) (FST):  FST defines fields that can be 

searched in the database. Search is made possible by creating an 

inverted file of the terms in the search fields.  

 

1.2 Installation of WINISIS 

 
Double Click on the Wisis1.5.exe1 to start its installation. 
 
Figure 1  
 

 
                                            
1Winisis and associated software are obtainable from Unesco website 
www.unesco.org/isis.  You can download Winisis directly from 
www.unesco.org/isis/files/Winisis15_3.exe 
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http://www.unesco.org/isis
www.unesco.org/isis/files/Winisis15_3.exe


Then you will get the first screen in the installation process as follows: - 
 
Figure 2
 

 
 
Click on the Continue button and you will get the following window 
 
Figure 3  
 

 
 
 
Click on the Continue button.  
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Figure4

 
 
 
Click on the Continue button    
 
 
Figure 5 

 
 
Click on the Continue button  
 
 
 
 
 
 

 10



Figure 6 
 

 
 
Click on the Continue button  
 
 
Figure 7 

 
 
Click on the Continue button   
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Figure 8 
 

 
 
Click the OK button and you will be notified the successful installation of 
the programme. 
 
Figure 9 
 

 
 
Click the OK button to finalise the installation. 
 
 
The next step is the creation of database  
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1.3 Creating the database  
 
A database is a set of records or pieces of information about entities 

such as books, journals, articles or conference proceedings. A record is 

made up of a number of fields. Each field contains data about particular 

facts like author, title, keyword etc. 

 
How to create the database of digital collection of documents, using 

Winisis? 

In order to create an archive of digital documents, you need to collect a 

few full text documents and place them in a folder in your computer.  

Create a database of the above digital documents in Winisis2. The 

database can have any number of fields. But our sample database will 

have the following tags and fields for convenience. 

 

10  Author 
20  Title 
30  Keywords 
40  Fulltext 
 

(It is advisable to use an international standard, such as MARC21 or 

Common Communication Format for Bibliographical Description (CCF/B) 

for the purpose) 
 

Creation of database by using Winisis is very easy and automatic.  
 

For creation of database, open the Winisis programme by clicking 

CDS_for Windows under Start/Program. Then you will get the following 

screen: - 
 

 

                                            
2 Winisis is installed in C:\winisis folder. Data subfolder holds the Winisis data files. Each Winisis 
database consists of around 12 files. Files ending with .mst, .fdt, .pft and .ifp are important data 
files. Syspar.par is the parameter file that determines many things. Each file in the Winisis must 
have a numeric tag to identify it. You cannot change the tag number of a field name without 
resorting to import or export process. 
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Figure 10 
 

 
Click on the Database drop down menu and select New as follows: - 
 
 

Figure 11 

 
Now you will be lead to the following screen: - 
 
 
Figure 12 
 

 
 
Give a database name such as NEW and click on the Ok button. Then 
you will get the following screen: - 
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Figure 13 Field Definition Table  
 

 
 

You need to provide the Tag number (10, 20, etc) and Field name 

(Author, Title etc) of your choice in the Name box. Beginners may choose 

Alphanumeric under Type. Click the check box under Rep for multiple 

occurrence of the field. Pattern/Subfields can be ignored, if you are not 

dividing the field into subfields. Click the Add button every time on 

completion of each entry. 

 
On entering the tag numbers and the name of fields, click the arrow 

button at the right bottom corner to move on to the next screen.    

 

Figure 14 Data Entry Worksheet 

 

 15



In the above screen, highlight the fields (in the left pane), which you want 
to include as the Data Entry Field and click on the side arrow button 
in the middle so as to get the field included as a Data Entry Field.  
 
If you click on the double arrow button above, all fields will be selected 
as Data Entry Fields and will appear in the right pane as above. Then 
click on the green arrow button to move on to the following screen. 
 
Figure 15 
 

 
 

Click Yes to launch the wizard Print Format Assistant 

 

Figure 16 Choose a Print Format 

 
Select the appropriate print format and click Ok button to get the print 

format screen as in Fig 17. 

 

Decorated format is the preferable choice for the beginners. 
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Figure 17 Print Format 

 
 

In the print format shown above, you need to add the following format 

line in order to appear a hypertext link with the words Click here.  The 

hyperlink will be cross-linked to the full text document, the full path of 

which is provided in the tag 40 Full text 

 

Link ((‘Click here’), ‘OPENFILE  ’, v40) 

 

Ensure to provide a space between the OPENFILE command and the 

single quote, and the command OPENFILE should be in upper case as 

shown above.  

 

The meaning of the command is that, when you click on the ‘Click here’ 

link, the click will automatically result in opening the digital document 

denoted in the field V40, in a new window. 

 

The resultant print format would appear as in Figure 18. 
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Figure 18  

 
 

Click the Side arrow button to move ahead and you will be asked 

whether to launch the Dictionary Assistant. Dictionary Assistant will 

help you to select the fields for indexing and the indexing technique for 

creation of Inverted File Index. 

 
 
Figure 19 

 
 

Click Yes to launch the Dictionary Assistant. 

 

You will then get the following screen. 
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Figure 20 Field Selection Table 

 
 

Put x mark in the check boxes on the left side of the field names and 

select the appropriate Technique for indexing from the dropdown menu 

at the right top. The most commonly used indexing techniques are            

0-by line and 4-by word. Select 4 by word indexing technique in the drop 

down menu. Then click Ok to move on to the next screen. 
 

Figure 21 Field Selection Table-Definition 

  
 

Here you can change the indexing technique. If you need to correct any 

entry, just click on the entry in the entry box and that will appear in the 

edit box shown above. You can edit the text, if needed. Then click the 

Terminate button and you will get the following message.  
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Figure 22 

 
Then click the Yes button for confirmation and you will be notified that 

the database has been created. 

 

Figure 23 

 
 

Click the OK button. 
 
Now creation of the database is over.  

 
Figure 24 

 
Then select .mst file of the new database (new.mst in this example)  
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Figure 25 Opening the Database 

 
 
Click the Ok button to get the following screen. 
 
Figure 26 Database Opened 

 
 
Database definition process is over and you need to enter the data by 

opening the Winisis as in Fig 26 by clicking the Data entry under Edit 

menu.  

  

You will then get the following screen in Figure 27. 
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Figure 27 Data Entry Window 

 

Click here 
to enter a 
new record 

 
 

Entering Data in the Database 

Enter the data of all documents of the digital collection. The full path of 

the fulltext documents including extension (.pdf, .doc etc.) should be 

entered in the Fulltext field.  

 

Figure 28 

 

Save button 
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Save and New
button 



Figure 29 

 
 
If you provide full path3 of the documents in the Fulltext field and place 
those documents in the location shown in the field, a click on the link 
will open the document automatically. 
  
The database creation is over and you can pass on to the next chapter  
that deals with creation of web front end. 
 

                                            
3 But remember that if you want to convert this database into a cd-rom 
library with GenisisCD as explained in chapter 3, you need to change the 
field data of the fulltext field with filename (ram.pdf) of the document 
alone, instead of full path of the document as provided above.  
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CHAPTER 2 
 
 

Creation of Digital Archives with 
GenisisWeb 

 
The Winisis database can be made accessible to remote users over a 

computer network with GenisisWeb front-end, using a webserver 

software. 
 

A webserver software Apache4 and GenisisWeb need to be installed, for 

the purpose. Apache is a free software used for making any computer a 

server in a client-server mode. 

 

2.1 Installation of Apache Webserver  
If you want the remote users in your network to access the database 

stored in your computer, you have to make your computer node a 

webserver, with Apache or similar software. 

 
 

                                           

Installation process 

Double click on the icon and installation of Apache will start 

 

 
       
       

 
 
 

 
4 Apache software is used for making any computer a file server in the client-
server mode. Apache 1.3.17 is obtainable from the 2001 Unesco cd-rom 
entitled Information processing Tools that contained CDS/ISIS 1.4.  Many 
versions of the software are available freely from internet site 
http://www.apache.org/. But ensure that Apache is installed in the folder 
C:/Program Files/Apache Group/Apache for our purpose. 
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Figure 1 
 

 
 

 
 
 
 
 
 

 

Click on the Next button. 

 

Figure 2 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Here you have to type any domain name, server name and email address. 

These names need not be real.  

 

Click the Next button and the following screen will appear. 
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Figure 3 

 
Select Complete (to install all program features) and click the Next 

button. 

 

Figure 4 

 
Click on the Next button confirming the suggested path for installation, 

if you are using the version 1.3.17. 

 

If you are using Apache 2.2.3 version, ensure to change the path to 

C:\Program Files\Apache Group\Apache 
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Figure 5 

 
Click on the Install button and you will get the following screen.  

 

Figure 6 

 
Click the Finish button, when the installation process is completed. 

 

Once Apache is installed, you can start installing GenisisWeb. 
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2.2 Installation of GenisisWeb 

 
Download the GenisisWeb5 program from www.scribnet.org website or 

Unesco website. 

 
 

 

 

Unzip the downloaded f

 

 
                                          
5GenIsisWeb created by 
publish your winisis dat
The software is 
download/genisisweb3-
winisis/genisis/web/ge
An English manual We
3.0.0 by Deepali Talag
genisisman-ver.3.pdf 
 
 
 

 

Click here to download 
English version 
ile.  

  
Pierre Chabert (pichabert@wanadoo.fr]  allows you to 
abase in a computer network or internet website. 

available at http://www.scribnet.org/ 
2-1.zip or http://www.unesco.org/isis/files/ 
nisisweb.exe 
b Interface for CDS/ISIS GenIsisWeb Version 
ala, is available at http://www.nsf.ac.lk/purna/ 

28

mailto:pichabert@wanadoo.fr
http://www.scribnet.org/download/genisisweb3-2-1.zip
http://www.scribnet.org/download/genisisweb3-2-1.zip
http://www.unesco.org/isis/files/winisis/genisis/web/genisisweb.exe
http://www.unesco.org/isis/files/winisis/genisis/web/genisisweb.exe
http://www.nsf.ac.lk/purna/genisisman-ver.3.pdf
http://www.nsf.ac.lk/purna/genisisman-ver.3.pdf


 Figure 7 GenisisWeb zip file 

 
 

Double click on it and it will show the following screen suggesting a path 

where you want to copy the files. Give the proper path and click on the 

Decompresser button (Fig.8) 

 

Figure 8 
 

  

 

 

 

 

 

When you decompresser the downloaded zipped file, you will get the 

following three files. 

 

Figure 9 
 

 

 

 

Double click on the setup.exe file shown above 

 

Then you will get the first screen in the installation process as follows: - 
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Figure 10 

 

 

 
 
 
 
 
 
 
 
 
 
 
Click on the OK button to get the following screen 

 

 
Figure 11 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 e

 
 
Click on
 
 
 
 
 

 

Click the icon to continu
 the computer icon on the left side in the above screen. 
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Figure 12 

 
Click on the Continue button   
 
Figure 13 
 

 
 
 
Then click on the OK button to finalize the installation. 
 
 
Copy two GenisisWeb files to Apache - A Pre-requisite 
 
Before you start the GenisisWeb for the first time, copy the following files. 

1. Copy the "wwwisis" folder in GenisisWeb to "htdocs" folder in 

"Apache". 

2. Copy the contents (all files) in the "bireme" folder in "GenisisWeb" to 

the "cgi-bin" folder in "Apache" 
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Starting Apache Web Server 
Before you start GenisisWeb, you have to run the Apache webserver. To 

start Apache, follow the steps as follows: - 

Click on Start ⇒ Programs ⇒ Apache httpd Server ⇒ Configure 

Apache Server ⇒ Start Apache in Console  

 
Figure 14 
 

 
When Apache starts running, you will get the following window (Fig.15). 

Then click on the Esc key in the computer or minimize button on the 

screen.  

 

Figure 15 
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You can now test to see if Apache is running properly by opening the web 

browser. Open the web browser and type the address  "localhost" in the 

address bar and you should get the following screen. (Fig.16) 

 

Figure 16 
 

  
 
 
You can then design your web interface for Winisis with GenisisWeb 
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2.3 Creating the web front-end with GenisisWeb 
 
Starting GenisisWeb 
 
Convert the GenisisWeb in to English version, when you run it for the 

first time, by following the steps shown below (Fig.17) 

 
Figure 17 

 
 
You will then get the following screen (Fig.18).  

 
Figure 18 
 

 
 
Select language as English (Angalis) 
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Figure 19 
 

 
 
 
 
 
 

Click here to select 
the Subfolder 

Click here 
to choose 
the cgi-bin 

 
Select the Sub-folder "wwwisis" in "Document root" and click the side 
button.  
 
Then the following screen with a message in French, asking you whether 
to use the Apache, will appear. 
 
Figure 20 
 

 
 
Click the Qui button 
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Figure 21 
 

 
 
Click the Valider button 
 
 
 
Figure 22 
 

 
 
Click the Ok button 
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Figure 23 
 

 
 
Click the Ok button.  
 
Check whether everything is correct as instructed in the above screen. 

Now you have to restart GenisisWeb as detailed in the next section. 

 
 
Creation of GenisisWeb front-end 
 

Open GeinsisWeb by clicking on Start ⇒ Programs ⇒ Application 

Genisis ⇒ GenisisWeb-Access base ISIS sur le web. Then you will get 

the following screen (Fig.24) 

 

Figure 24 
 

 
Click on Application menu and select New (Fig. 25) 
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Figure 25 
 

 
 
Then the following screen will appear showing the names of Winisis 

database available in the computer. 

 

If your Winisis data is in any other folder other than in the default folder 

(C:\Winisis\Data), choose the .mst file from that folder. 

 
Figure 26 
 

 
 
When you select the database (.mst) and click the Open button in the 
above screen, you will get the following screen. 
 
Figure 27 
 

 
 
Give any name like MYWEB for your application and click OK 
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You will get three form design formats as in Fig.28 
 
Figure 28 Form Design Formats 

 

 
 
 
 
 

Click here to add fields 

The form design formats are  
¾ Query form 
¾ Format 'listing' 
¾ Format 'details' 
 

Query form      : allows you to design the web like Query Form  - a front-
end form for searching the Winisis database.   

 
Format 'listing' : allows you to design an initial display format.  
 
Format 'details': allows you to design a detailed display format.    
 
Since detailed display format is inessential for our purpose we haven’t 

described the creation of Format ‘details’. 

 

Designing the query form 
 
To design the query form, you have to click the Add button in order to 

add fields. Click the Add button at the bottom of the query form and you 

will get the following screen: - 
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 Figure 29 

 
 
 
 

Select the butto
index button on

 
In the above scre

(as it allows searc

and then click Ok
 
The items appear

your Winisis data

appear that sear

fields, you have t

until you put all t

 

As well, you can 

and the appearan

the left side of the

 

Now you will get 

fields alone has b

 

 

Click on the Field to create a search
box for the field on the query page 
 
 
 
 
 
 
 
 
 
 
 
 

n to create an 
 the query page 

en, it is preferable to select All fields from the left panel 

h by any term in the inverted file index of the database) 

.  This will make the query form very simple. 

ing on the left panel are the fields you had included in 

base. You may select only one field at a time so as to 

ch box in the Query form.  If you want to select more 

o click on Add button and select fields again and again 

hose fields.  

select your option with regard to the search operators 

ce of the index button by clicking the check boxes on 

 above screen. 

the following window.  The screen below shows that All 

een choosen. 
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Figure 30 
 

 
 
 
Select any or all the three tabs Form, Index and Page appearing on the 

right side of the above screen for appropriately modifying the 'look' of the 

Search-box area, Index Page and Display Area of query form respectively. 

You can play with the options in the screen and can choose anything you 

prefer to have a beautiful look for your web front end. 

 

How to change the page display of the query form 
 
Figure 31 
 

 
 
 

 

Click here to 
change background 
Click on this button 
to edit the title of 
your query form 

Put tick mark to 
show the number of 
records to be 
displayed in a 
search. 
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Designing format 'listing' 
 
Then click on the ‘Format-listing' window and you will get the following 
screen. It will create a default search-result page, which will display all 
fields contained in the database, if you do not do anything at all.  
   
Figure 32 Default Search-Result Page Definition 

 
 
Or else, you can design your own customised search-result page with 
Add button, as detailed below: -  
 
Click the Add button at the bottom so as to get the following window 
 

 
Figure 33 Create Customised Search-Result Page 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Click here to select the 
field and you will get 
this drop down menu 

After selecting the field 
click here 

Click here to add link 

In the above screen, select the appropriate Field by clicking the drop 
down menu at the top.  
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Then click the down arrow button at the middle and finally click the Ok 
button. 
 
Now select the next Field by clicking Add button till all Fields except 

Fulltext are selected. Fulltext field needs to be provided with links, for 

opening the fulltext document.  

 
Figure 34 

 
 
Now add the Fulltext field. The Fulltext field need to have a link to the 
full text documents. 
 

 
Figure 35 Providing Link to the Fulltext Documents 
 

 
 
Click on the down arrow button at the middle as above, so as to display 
the Fulltext file C:\Windows\Desktop\new\ram.pdf. 
 
Then select the drop down menu appearing against link and select          
To external resource (pdf, doc…), if the full text documents are pdf, 
doc, html etc. Then you click Ok button to save it. 
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You may move on to the next screen in Fig 36 
 
Figure 36 
 

 
 
Designing of two forms (query form & format ‘listing’) as detailed above 
are over and you may ignore the Format ‘Details’. 
 
Then click on Application drop down menu and select Create 
application as in figure 37 
 
 
Figure 37 Create Application 
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You will be lead to the following message. (Fig.38) 
 
Figure 38 Test the Application 
 

 
 
Click on the Yes button and the query form you had created will appear 
as follows as in Fig 39. 
 
 
Figure 39 A Test Window -Query Page 
 

 

 
 
Type any search term in the Search box for all fields to make a search. 
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Figure 40 Search Window 
 

 
 

 

Then click the Search button to get the following screen containing the 

result. 

 

Figure 41 Search Result Page 

 
If you click on the link (C:\Windows\Desktop\new\ram.pdf) against the 

field Fulltext provided above, appropriate document would be opened, 

automatically as follows: - 
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Figure 42 An Opened Full-text Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Close the test window and continue as in figure 43 
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Installing TCP/IP protocol  

If your computer needs to work with http address, you need to install the protocol TCP/IP  

• Click Start menu 

• Then click Settings,  

• And click Control Panel, and then double-click Network icon to open the

network dialogue box. Then the Network dialog box will be opened. 

• Then click Add. 

• Click Protocol, and then click Add.  

• Then click Microsoft under Manufacturers, and in Network   Protocols, click

TCP/IP  

You must know the name or number of your computer to type the http address. 

 

How to find out the name of your computer? 

• Open the Network dialog box as described above.  

• Click the Identification tab.  

• The name of your computer name will appear there or type a new name if you

want to re-name the computer.  

How to find out the number of the computer? 

• Open the Network dialogue box 

Select TCP/IP under Configuration and Click on Properties button to see the IP

address of the computer 

 



Save the application 
 
Finally save the application by clicking the Save under Application drop 
down menu as in figure 43. 
 
Figure 43 

 

 
  
 
Figure 44 
 

 
 
Click the OK button in the above window.    
 
Now, you can open the GenisisWeb application by typing the http 
address http://computername/wwwisis/databasename/ form.htm in the 
internet explorer address bar. 
 
(Eg. http://127.0.0.1/wwwisis/new.01/form.htm will be the address for 
the sample application created above. The computer will add.01 to the 
first databasename and .02 to second databasename and so on).  
 
Ensure that the folder containing fulltext document is shared with read-
only access.  
 
You can allow others to search the database with the above http address.  
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2.4 Publishing the Database in a website    
 
 
You can publish the Winisis database application created above in a 

website by export function of the GenisisWeb software.     

 
Modify the Fulltext field of the Winisis database before exporting 
 
In order to put the above database application in a website, you need to 

modify the field 40 Fulltext. The path provided in the field 40 Fulltext 

for full-text documents earlier is C:\Windows\Desktop\new\ram.pdf. 

That path does not work in the webserver, as the full path of the fulltext 

documents, when you put them in a webserver, will be different. 

 

So modify the data elements of the filed 40 Fulltext in such a way that it 

should show the exact path (web address) of the relevant documents 

when we place them in the website. The web address of the documents 

should be website address/folder name/document name with extension. 

For example, if you decide to put your documents in a folder namely pdf 

in your webserver space and if the website name is www.kilaonline.org, 

the path of a document should be www.kilaonline.org/wwwisis/ 

pdf/ram.pdf. You can place the fulltext documents anywhere in the 

webserver, but the path you provide against the fulltext field should be 

appropriate. 

 

Modifying the database by using global replace 

Modify the already created database as mentioned above with the help of 

Global Replace, as detailed in the annexure. 
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Create the modified GenisisWeb application 

Create a GenisisWeb application with the modified Winisis database, as 

detailed early in this chapter.  Then you may export the application and 

copy the folders to the webserver, following the steps detailed below. 

 

Exporting the application to the web-server 
 

Open the created GenisisWeb application. 

 

Click on Export to web server under the Application drop down menu 

as in figure 45 

 
Figure 45 Exporting to Web-server 
 

 

 
 
Then you will get a dialogue box in Fig.46 
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Figure 46 

 
 

In the above screen you can choose the operating system Windo

Unix. Then type a path to export (as shown on left bottom of the 

eg. .../htdocs/wwwisis/new/) on the box for Your's application 

as above. 

 
Figure 47 

 
 

Then click the Ok button to start the export process. 
  
On completion of export process, you will get a message. The m

will give you instructions on what to do. 
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Figure 48 Instructions 
 

 
 
Then follow these steps 

  

1. Create a new folder wwwisis in the htdocs and then create 
another subfolder namely new in wwwisis folder of the server 
computer (..htdocs/wwwisis/new) 

2. Copy the contents of   the folder export (under GenisisWeb) 
from the first computer to the new folder (..htdocs/wwwisis) in 
the server computer 

3. Copy the   contents of the cgi-bin (of GenisisWeb) to the cgi-bin 
in the server computer  (The contents of the cgi-bin will be 
identical files for any database) 

4. Place the fulltext documents in the webserver in accordance 
with the document path you had provided in the field 40 
Fulltext and 

5. When you type http:/servername/wwwisis/new/form.htm, 
the query form will appear. The query form allows you to search 
the document collection. 
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CHAPTER 3 

 

Creation of CD-ROM Libraries with GenisisCD 
 

 
GenisisCD6 software can be used for creation of cd-rom libraries. Earlier 

used database need to be slightly modified for creating a sample cd-rom 

library.  

 
Modify the earlier used Winisis database  
 
The Winisis database used for GenisisWeb application describe in 

chapter 1, needs to be modified slightly.  

 

The only change to be made to the Winisis database is to substitute the 

document file name with extension (eg. ram.pdf) in the Fulltext field 

instead of the full path file name in the GenisisWeb application. 

Everything else can be retained as such in the database.  

 

The filename of the full text documents in the field Fulltext can be 

altered by choosing Global edit7 feature of the Winisis.   

 

                                            
6 The GenisisCD software created by Pierre Chabert (pichabert@wanadoo.fr] is 
available at http://www.scribnet.org/download/genisiscd.exe. Download the English 
version. 
7 For details, see the Annexure I 
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3.1 Installation of the GenisisCD 
Download the GenisisCD program from www.scribnet.org website or 

Unesco website. 
 

 Figure 1  

 
 

Unzip the downloaded zipped file and you will get the follow
 

Figure 2 

   
Double click the setup.exe file given above 

 

Then you will get the first screen in the installation process
 

Figure 3 
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 as follows: - 

 



Click on the OK button and you will be lead to a screen as in Figure 3 as 

follows: - 

 
Figure 4 
 

 

Click the 
computer icon 
to continue 

Click on the computer icon on the left side and you will get the following 
screen: - 
 

Figure 5 
 

 
 
Click on the Continuer button and you will be notified the successful 

installation of the program.  
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Figure 6 

 
  
Click on the OK button to finalize the installation. 
 
 
 
3.2  Creation of GenisisCD files for burning into a cd-rom 
 
To start GenisisCD program, go to Start\Programs\Applications 

Genisis\GenisisCD-BaseISIS as follows: -  

 
Figure7  
 

 
 
Then you will get the following screen in Figure 8 
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Figure 8 
 

 
 
Click Configuration menu and select Options to get the following 
screen. 
 
 Figure 9 
 

 
 
In the above screen, click on the language drop down arrow k

the language English and click the Ok button.8 
Click on the Application menu and select New as follows.  

                                            
8 If your installation doesn’t show English language, create a n
with the following contents.  
[OPTIONS] 
LANG=en  
Save it with the name GenisisCD and put it in the folder 
Files\GenIsisCD 
 
The application will be converted to English when you refresh it. 
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Figure 10 

 
 
Then the following screen will appear. 
 
Figure 11 
 

 
 
 
Select the .mst file of the modified Winisis database and click the Open 
button in the above screen. Then you will get the following screen: -   
 
Figure 12 
 

 
Give a name like MYWEB for your application and click OK. 
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Then you will get three form design formats.   
 
Figure 13  
 

 
 
The form formats are  

¾ Query form 
¾ Format 'listing' 
¾ Format 'details' 

 
Query form allows you to design the web like Query Form - a front end 
form for searching the database.  
 
Format ‘listing’ allows you to design a short display format. If you don't 
design a format, the default format will appear automatically. 
 
Format 'details' In GenisisCD, format 'details' is not organically linked 
with format 'listing' and hence it has not been used in this part of the 
manual. You can provide detailed display with format 'listing'. 
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How to design the query form? 
 
Query Form is the front-end web form for search by users as if in a 
website. It has a search box, submit button and other buttons.  
 
To design the query form, select the Query form by clicking on the top of 
it.  
 
Figure 14 Adding field/s to Query Form 

 

 
 
 
 
 

Click here to add fields 

 
Then click on the Add button at the bottom of the query form in Fig 14 
 
When you click on the Add button you will get the following window: - 
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Figure 15 Adding All fields 
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Access 
to index
n the above screen, it is preferable to select 'All fields' from the left 
anel (as it allows search by any term in the inverted file index of the 
atabase) and then click Ok 

he items appearing on the left pane are the fields included in the 
inisis database. Select one field each at a time so as to have search box 

or all those fields in the Query form.  

ore fields can be included in the search box by clicking on “Add” 
utton and clicking on Ok button. You can continue with one by one, 
ntil you select all fields and create search boxes for all fields. 

rom this format, you can create search operators check box and index 
utton by marking the appropriate check box. 

hen you will be lead to the following window: -  
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Figure 16 Design Query Form 
 

 
 
Select any or all the three tabs Form, Index and Page appearing on the 
right side of the above screen for appropriately choosing the 'look' of the 
Query Form, Index Display Page and Search Display Page. 
 
You can play with these options and choose anything you prefer to have 
a beautiful look for your cd-rom library. (For instructions to design a 
query form See chapter 2 figure.29) 
 
 
Designing format 'listing' 
 
Click on the 'Format-listing' window and you will get the following default 
form. If you don’t Add any field, the default search page will appear. 
   
Figure 17 Format ‘listing’ Window 
 

 
Click the Add button at the bottom to create a customized search-result 
page and you will get the following window. 
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Figure 18 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click here to add link 

After selecting the field 
click here 

Click here to select the 
field to  get this drop 
down menu and select 
the field 

From the above screen, select the appropriate Field in the drop down 
menu and then click the down arrow button at the middle and then 
click the Ok button. 
 
Then select the next field by clicking the Add button till all Fields 
except Fulltext are selected. 
 
Figure 19 
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Select the Fulltext field as follows: - 
 
Figure 20 Linking Fulltext Field to the Documents  
 

 
 
Then click on the down arrow button at the middle so as to display the 
Fulltext file name ram.pdf.  
 
Now select the drop down menu appearing against link and select To 
external resource (pdf, doc…), if the full text documents are pdf, doc, 
html etc. Then click the Ok button to save it. 
 
 

Then move on to the next screen in Fig 21 
 
Figure 21 
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After designing two forms (Query form & format ‘listing’) as above, you 
may click on the Application drop down menu and select Create 
application in figure 22 
 
Figure 22 Creating Application 

 
 
 
On clicking the Create application, you will get the following screen as 
in Figure 23 
 
Figure 23 

 
 
Click the OK button.  
 
Now your application would be created in the folder C:\Program 
Files\GenIsisCD\appli\Cd.01.  
(The second application will have the name Cd.02, third one will have 
Cd.03 and so on) 
 
 

 66



3.3 Finalize the cd-rom application 
 
Click on the Application drop down menu and select Finalize the 
application (before CD burning) as in figure 24 
 
Figure 24 Finalize Cd-rom Application 
 

 
 
Then you will be lead to the following screen. 
 
Figure 25 
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You may put 9 tick mark on the check box so as to get the auto run 
feature for the resultant cd-rom. 
 
Then click Ok button in the above screen in order to move on to the 
following screen. 
 
Figure 26 
 

 
  
Click Yes in the above screen. 
 
Figure 27 

 
 
Click the OK button in the above screen. 
 
Figure 28 
 

 
Allow the above screen to run till its end until it is finished. 
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Now click the Close button (x) to close the program and to get the 
following screen. 
 
The following screen will give the instructions in burning the cd-rom. 
 
Figure 29 Instructions of Burning the Cd-rom 
 

 
 
Click Exit to close the cd-rom file generation process. 
 
 
 
3.4 Modifications to be made before burning the cd-rom  

 
Open the html folder (C:\Program Files\GenIsisCD\appli\Cd.01\html] 
and Delete the index file (index.htm). 
 
Then open the base_databasename_01 (eg.new.o1) folder (C:\Program   

Files\GenIsisCD\ appli\Cd.01\ html\ base_databasename_01) 

Copy form_databasename (eg. form_new) file and paste it in the html 

folder. Then rename the form_ databasename file in html folder into 

index. 
  
Create a new subfolder (say pdf) in the "html" directory. Then copy the 

set of your full text documents to the pdf subfolder (C:\Program Files\ 

GenIsisCD\appli\Cd.01\html\pdf).  
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Enable the resultant cd-rom to work in a computer with any cd-rom 

drive letter 

 

Open the liste_databasename htm file in the base_databasename 

folder 

(C:\ProgramFiles\GenIsisCD\appli\Cd.01\html\base_databasename 

\liste_databasename) and it will look as follows: - 

 

Figure 30 

 

 

 

 

 

 

 

 

 

 

 

Then right click on the page with the mouse and select View sources to 

ee the html code of the page. Then html codes will appear in a notepad 

le as in figure 31. 
 

ow, you have to find out the html source pertaining to the field tag, 

hich provides link to the full text documents (in the sample database 40 

 the field tag).   

s

fi

N

w

is

 

The html source line can be found out easily by searching for the * using 

the Search function of notepad. 
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Then add the words [Rep]pdf/ in front of the * mark coming just before 

the field tag number and the resultant line would look as follows as in 

figure 31 

 

 {<a target="_blank" href="[Rep]pdf/*">[40]</A></B></font><BR>} 

 

Figure 31 
 

 
 

If you provide this syntax [Rep], it will replace the letter of the cd-rom 

drive of the computer where cd-rom is put, even if it is D, E or F.  

 

The symbol "*" (star) will replace the name of the full text document file 

mentioned in the field 40. 

Save the changes  

Then burn the contents in the folder cd.01 (C:\Program 
iles\GenIsisCD\appli\Cd.01) on a blank cd-rom. 

  

F
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3.5 Testing the burned cd-rom  

 
om in any computer and the following screen will 

 the autorun feature doesn’t work, open the cd-rom drive to get the 
llowing screen.  

igure 32 

 
Installing the cd-rom 

Put the burnt cd-r
appear automatically. 
 
If
fo
 
 
F
 

 
 
 
Click on the Install the CDROM button shown above and follow the on-
screen instructions to install the program. 
 
Running the cd-rom 
 
Figure 33 
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Then go to Start/programs/cdrom_name/query the cdrom_name to 
open the query form as follows: - 
 
Figure 34 Search Page of Genisis CD 
 

 
 
Type any search term in the search box for all fields to make a search. 
 
 
Figure 35 Search Window 
 
 

 
 
Click Search button to get the following search result. 
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Figure 36 Search Result  
 

 
 
 

 you click on the link (ram.pdf) appearing against the field Fulltext

, automatically. 

igure 37 Fulltext Document Opened 

If  

provided above, appropriate document would be opened

 

F
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Sample Pages of a Cd-rom Library on Poverty   
 
 
Query Page 
 

 
 
 
 
Search Result for the Term Poverty
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An Opened Full-text Document  
 

 
 
 
 
Sample page of cd-rom library on Local Governance 
  
 
Query Form   
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Search Result for the Term Democracy  
 

 
 
 
 
Another Opened Full-text Document Showing Bookmark of Chapters
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ANNEXURES 
 
 

Annexure 1 
 
Modifying a Winisis database 
 
This part of the manual describes how to modify various components of the 
Winisis database. 
 
Modifying the Field Definition Table 
 
You can add an extra field to any Winisis database by modifying the Field 

Definition Table as described below 

 

Adding a field 

Open the database 

Choose Edit ⇒Field Definition Table from the drop down menu bar. 

This will open up the Database Definition-Field Table window.  

The cursor will be in the Tag box to add a field, type the Tag Number, 

press {tab} to move the cursor to the Name.  

Then type the name of field, leave the next box as Alphanumeric and 

click the check box, if the field needs to be repeatable. 

Click on the Add button. 

Then click the Ok button when you finish and Save it. 

 

If you add a new field, that needs to be added to the Worksheet, Print 

Format & Field Selection Table. 

 

Removing a field 

You can remove a field, by opening Database Definition-Field Table 

selecting the Field and clicking on the Delete Entry button. 
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Modifying the worksheet or creating a new one 

 
Select Edit ⇒ Data Entry Worksheets.  

The added field will be displayed on the Fields window on the left side. 

 
Double click on the new field and that field will be added to Data Entry 

Field box on the right. 

 
Your database will be ready to accept the data in the new field. 

 

Modifying Field Selection Table 
Open the database 

Select Edit ⇒ Field Selection Table 

Choose the added field from the drop down menu shown against the 

Tag/Name 

Choose the Technique from the drop down menu 

Click Add and Click Ok to save it 

 

You can edit the Entries by double clicking on it and moving it on to the 

Format box 

 

Creating a new Print Format for the existing database 

 
Creating a new print format 

Select Edit ⇒ Print Formats  

Select New 

Give a new name for print format 

Put a tick mark on the box for Don't clear current format in order to 

make it as an additional print format 

Click the Ok button to create a new print format 
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Then Print Format Assistant will be launched. 

Choose a format from among five choices of print formats, click Ok and 

save it 

 

Creating a print format while searching 

 

While browsing, click on the icon showing a pencil on paper. 

A window containing the format language will appear. 

You can edit the format. 

Then click on the lighting symbol to see that the change is implemented 

but not saved. 

Then click on the floppy disk icon to save the change if it is in the right 

manner. 

 

Modifying or adding Print formats 

 

To set up a new print format, choose Edit ⇒ Print format. Select New in 

the print format screen. 

 

Give a name in the text box and click Ok 

 

Then click Yes to launch Print Format Assistant  

Choose a print format from the five choices and click Ok 

 

The editable print format will appear. If necessary, edit the print format 

and click Ok to save it. 
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Modifying the print format  

 

Print format (.pft) determines the manner in which the database records 

are displayed. The default Print format must have the same filename as 

the database. So in order to make another print format as the default 

print format, change the file name as that of the database name. 

 

In Print format, fields are specified by using v in front of the tag. eg v10. 

Text between single or double inverted commas will appear as it is, in the 

display. eg. "Author:" 

 

Slash (/) will start a new line. 

 

In the Print format, you can use conditionals as follows. 

IF v80='BOOK' THEN v10/v20/v30 ELSE IF v80='ARTICLE' THEN 

v20/v30/v40/v50. It means if v80 is 'Book' print v10/v20/v30 or else if 

v80 is 'Article' print v20/v30/v40/v50 

 

You can use the name of a print format fmt1.pft and fmt2.pft as follows: -  

IF v80='BOOK' THEN  @fmt1  ELSE  @ fmt2 

 

If you provide a line   Link (('Go to the website'), 'OPENFILE ', v40) in 

Print format and give the web address of the site (say www, kilaonline.org) 

in v40, a link will appear with the words Go to the website. A click on 

the hyper link will take you to the website, if the computer is connected 

to the internet.  

 

If you provide a line   Link (('Show a picture'), 'OPENFILE ', v40) in 

Print format and give the path of the image file in v40, a link will appear 

with the words Show a picture. A click on the link will open the image 
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file.  This feature has been made use of for creation of digital archives, in 

this manual. 

 

Modifying data in a database  
You can change a range of records (eg. mfn 200-350) in a database by  

 

• Global Add- adding a field to every record 

• Global Delete- removes a complete field from every record 

• Global Replace- replaced selected text in a field with text required 

 

Global Add 

 

Open database 

Select utils ⇒ Global Add 

Enter the range of MFNs eg. 10/350 

Select the field tag using spin box 

Type the text in the box at the bottom and it will be added to this field 

Click Ok and then a progress window will come up 

 

Global delete 

 

Open database 

Select Utils ⇒ Global Delete 

Enter the range of MFNs eg. 2/362 

Select the field tag by clicking the spin box 

Press Ok to see that the field will be deleted from every record selected 
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Global replace 

 

Open database 

Select Utils ⇒ Global replace 

Enter the range of MFN eg 8/321 

Enter the text in the Text to find 

Enter new text in the New text box 

Enter Tag number (You can specify one or more fields) 

Click Ok to replace the text 

 

Adding fields to searched records 
To add a field to every record you received in a search, use 

Utils ⇒ Global Add (search) 

 

To delete a field from every record you search, use 

Utils ⇒ Global Delete (search) 

The fields can be added to or removed from the searched records. 

 

Moving data from one field to another by Export/Import 
 

To move data from one field to another use export and import as follows. 

You can do this by Export and Import of data with a Reformatting Field 

Selection Table (FST). You need to create an FST for this purpose first 

and then to Import or Export the database with that reformatting FST. 

 

Creating a reformatting FST 

Choose Edit ⇒ Field Selection Table Select New button 

Enter a name for FST eg. CONV 

Then the database definition-extraction tables will be opened 

 83



Select the fields of the database from which you want to move the data to 

a new one, delete other fields and save it. 

 

Edit the FST in such a way that the Destination Field Tag (eg.100, 200) 

would appear in the left and the field tag from where you move the data 

appear in the third row  (12,13) as follows. 

 

CONV.FST 

100 0 V12 

200 2 V13 

 

Save the above FST and do the export or import of database using the 

above said Reformatting FST. 

 

Export and Import using the Reformatting FST 

Choose Export under Database 

Put the Reformatting FST in the Work folder 

Put the name of the Reformatting FST in the Export dialogue box 

Click Ok to Export the database as .iso file. 

 

Then import the exported iso file again as Winisis database  

The fields 12&13 would have changed as 100&200 
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Annexure 2 
 
Converting a paper document into a digital document 
 

The first step in converting a paper document into a digital document is 

to obtain images of all pages of the publications in digital format. 

 

The next step is Optical Character Recognition (OCR) to be done with an 

OCR software. 

 

The digitalisation process requires a scanner capable of working at a 

resolution of 300 dpi or above. The output format of a scanned page is a 

computer file that is usually stored in TIFF or Bitmap format. An 

uncompressed scanned page perhaps may have 2mb whereas a 

converted word/html page may have 5-15kb. 

 

Low cost flatbed scanners are the cheapest and widely available. Low-end 

scanners with sheer feeder, and professional duplex scanners are costly 

items. Every scanner comes with its own software and some may have a 

computer card also. Using the software provided with the scanner, a 

digital image of each page can be scanned and transformed into a 

Bitmap or TIFF image. These images should be stored in a folder with 

standard filenames. 

 

Now the image of the document should be subject to OCR process. The 

purpose of OCR process is to convert and obtain editable word, html or 

pdf version of the publication. Scanning and OCR are completely 

separate activities 

 

Give each document a typical number and put it in a suitable folder. 
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Fine Reader and Omni page are the user-friendly OCR programs. Fine 

reader is simple, cheap and flexible software costing reasonably. 

 

In many cases, OCR programs may not convert tables neatly. In such 

cases, tables can be saved as images. If a scanner is connected directly 

to the computer that runs the OCR software, most OCR programms can 

scan a page and perform OCR immediately. For low volumes of 

digitization, page-by-page scanning and OCR is a reasonable strategy. 

 

Making an image into an editable text using Fine Reader 

 

Open the OCR software (Fine Reader) and you will get the following 

window. 

 

 

 

 

Click here to 
scan the 
paper into an 
image first 

Click here to 
convert scanned 
image into word 
document 

 

Click here 
to read 
the 
scanned 
image  
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Put the document in the scanner and click Scan button as in the above 

figure to get the following window. 

 

 
 

Then select the part of the image  which you want to scan and click  

Scan ⇒ Return to FineScanManager 
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Now click the Read All button to read the image file. 

 

 
 
 
Click on the MS Word button to convert the text into word format. Then 

you will get the text in Word format as follows: - 

 
 
The word format can be saved, converted to any other format or used as 
needed. 
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Annexure 3 
                                                                                                                                        

Converting a Word document in to a PDF document 
 
Portable Document Format (pdf) is the most popular document format for 
web applications and it would be the most appropriate format for the 
applications mentioned in this manual. It can provide bookmarks that 
help us to navigate the document pages easily. 
 
Install Adobe Acrobat in your computer and your computer will be ready 
to convert a word document into Portable Document Format (pdf). You 
can use any other pdf writer bundled with scanner installation disk, to 
convert a word document into a pdf document. Those pdf writers may 
not be able to create bookmarks in the document. 
 
After installing Adobe Acrobat, Open Word, excel or power point document 

and click the PDF converter icon in the toolbar to convert the document 

in to a PDF document. 

 

 

  

PDF converter

  
 
 
 
 
 
 
 
 
 
 
 
 

Then the following screen will appear 
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In the above figure, click the Save button to save the document in the 
selected folder. 
 
 
Open the saved file as follows. 

 
 
How to put bookmark to the pdf document 
 
 
Bookmark in the pdf document helps one to move around in the 
document from chapter to chapter. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

Click here to open 
bookmark palette 
90



 
In Adobe Acrobat, click the New bookmark menu at the top of the 
Bookmark palette.  
 

 
 

 

 

Click here to get 
bookmark menu 

 
When you select New bookmark menu, you will get the text entry box for 
entering the bookmark label as follows: - 
 
 

 
 
To provide a bookmark for a page, place the page visible, type the text for 
the bookmark label, and press Enter.  
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To provide the new bookmark for another page/ chapter, move the scroll 

bar on to the selected page /chapter. Keep the page visible, click the new 

bookmark menu at the top of the Bookmark palette. Then type the 

bookmark label in the text box and press Enter. The bookmark label for 

the page will appear as follows. 

 

 
 
The pdf document with bookmarks will appear as follows and it provides 
easy navigation among the pages/chapters. 
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How to make a pdf document open with bookmarks by default? 
 
Even if you provide bookmark to a document, it may not show the 
bookmark automatically when opened, unless you make it as its default 
property. It is always better to have the document opened with 
bookmarks.   
 
Click on File ⇒ Document Properties ⇒ Open Options as follows 
 

 
 
 
Then you will get the following screen. 
 
 
 
 
 

 

Click here to show 
bookmark and page 
as default 

 

In the above screen, select Bookmarks and page and click the Ok 

button to make the pdf document open with bookmark window. 
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Annexure 4 
 

Publishing your website in internet using FrontPage 

In order to publish(upload) a website, you need to get a domain name for 

your site such as www.kilaonline.org and server space for uploading your 

website. Internet service providers usually do those things on your 

behalf, on payment. The next step is to create website files and folders 

using html editor like FrontPage. You can include the GenisisWeb 

applications, mentioned in chapter 2 also in your website. 

We will see how we can publish the web site in a webserver. 

FrontPage is a program that help you build your website and publish it in 

the internet. Once you publish the site, it will be accessible from the 

World Wide Web. 

To publish your site, please follow these steps: 

1. Connect to the Internet through your Internet Service Provider.  

2. Open your website with FrontPage using File ⇒  Open Web.  

3. In the File menu select Publish Web. 

 

  

4. Enter your domain name or http address (http://yourname.xyz)/ 
(http://yourIPaddress)  
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5. Click the Ok button.  
6. Enter the username and password supplied to you at the time of 

sign-up.  

 

 

7. Click Ok and you will be able to access the web server space 

allotted to you. You can cut and paste the files from your computer 

to web server as if you are working with two folders in two 

computers in your network. 

You can alternatively use Macromedia Dream weaver, cute FTP or even 

Internet Explorer to publish your site. Cute FTP is an excellent option. 

The purpose of this annexure is to show that publishing a site in the 

internet is an easy task unlike as many would think.  
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Glossary of terms 
 

 

Apache A free web server run in around 70 percent of the websites 
 

Client/Server mode A computer network model where the client- a web 

server- places a request and the server- a web server- serves the pages 

requested 
 

Cybrarian A librarian or researcher specialising in the internet, rather 

than books, as a source of information 
 

Digitalization is a process of turning a physical form of document into a 

computer readable format. Digitalization requires a scanner and an 

optical character recognition (OCR) software 
 

Ftp is file transfer protocol. It is a protocol used to upload or download 

files kept in ftp sites. You can upload/download information from an ftp 

site with a web browser 
 

Home page A page that acts like a front door to the content of the 

website 
 

Http is the short form for hyper text transfer protocol. It is a language or 

set of rules used to communicate between a server and browser 
 

IP address The address of a particular computer in a network which 

have four groups of three digit numbers, ranging from 0 to 255.                  

(eg. http://100.0.0.60) 
 

Link is a highlighted word that has a connection to a target page and a 

click on the link will open the target page 
 

MP3 is a compressed sound file meant for electronic distribution and it 

occupies only 10 percent of .wav sound files 
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OCR is a process of turning a scanner image into a computer editable 

text, so that the text can be retyped manually 
 

PDF Portable Document Format is suitable format for publishing in 

internet and distribute documents through e-mail 
 

Protocol A set of commands/rules that determine how two computers 

communicate with each other. http, ftp, TCP/IP etc are common 

protocols used in internet 
 

Query Any request for information from a database 
 

Query form is a submit form where you can type a query 
 

TCP/IP is the short form for Transfer Control Protocol & Internet 

Protocol. This protocol governs the sending of data from one computer to 

another computer in internet or a local network 
 

Upload Transferring information from a local computer to a remote web 

server across a network   
 

Web Browser software is used for viewing WebPages. It is needed to 

display the pages held in a web server. Internet explorer is the most 

popular web server. 
 

Web server is a computer in the internet that stores websites and serves 

the documents stored in the computer on search requests made through 

a web browser. 

 

Website A location in the World Wide Web identified by a web address 

such as www.kilaonline.org. Websites are stored in web servers. 

**** 
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